Mini-Sentinel Distributed Query Tool
DataMart Administrator Manual

Based on release 2.2

May 11, 2011

CONTACTS:
Jeffrey Brown, PhD
Harvard Pilgrim Health Care Institute
Jeff_brown@hphc.org

The PopMedNet™ application was developed under from the Agency for Healthcare Research and Quality, US Department of Health and Human Services as part of the Developing Evidence to Inform Decisions about Effectiveness (DEcIDE) program, awarded to the DEcIDE centers at the HMO Research Network Center for Education and Research on Therapeutics (HMORN CERT) and the University of Pennsylvania. The Food and Drug Administration’s Mini-Sentinel project provided additional support.
## Contents

1. Introduction ........................................................................................................................................... 1
2. System Overview .................................................................................................................................... 1
3. How to Login to the Web Portal .............................................................................................................. 3
4. How to Install the DataMart Client ........................................................................................................ 4
   4.1 Installing the DataMart Client ........................................................................................................... 4
   4.2 Installing the Database (DataMart) ..................................................................................................... 7
   4.3 Creating an ODBC Connection .......................................................................................................... 7
   4.4 Configuring your DataMart Client to use your ODBC Connection .................................................. 10
   4.5 Configuring DataMart Client Settings ............................................................................................... 13
      4.5.1 Unattended Operation Settings ................................................................................................. 13
      4.5.2 Low Cell Count Settings ............................................................................................................ 14
5. Processing Queries ............................................................................................................................... 14
   5.1 Displaying the Query List .................................................................................................................. 15
      5.1.1 Filtering Options ......................................................................................................................... 15
      5.1.2 Query Status .............................................................................................................................. 16
      5.1.3 Viewing Query Details ............................................................................................................... 17
      5.1.4 Query Result Parameters .......................................................................................................... 17
   5.2 Executing and Uploading Queries ..................................................................................................... 18
   5.3 Holding Queries ............................................................................................................................... 19
   5.4 Rejecting Queries ............................................................................................................................. 19
6. Administering Your DataMart ................................................................................................................ 19
   6.1 Viewing DataMart Information ......................................................................................................... 20
   6.2 Managing Your DataMarts ................................................................................................................. 21
   6.3 Determining which Types of Queries to Allow .................................................................................. 22
   6.4 Determining Who Can Submit Queries to your DataMart ............................................................... 23
   6.5 Creating an Audit Report ................................................................................................................... 24
7. Notification Options ............................................................................................................................... 25
8. Administering or Changing your User Profile ..................................................................................... 27
   8.1 How to Reset your Password ............................................................................................................ 28
9. Getting Help ........................................................................................................................................... 29
   9.1 Development and Funding Statement ............................................................................................... 29
   9.2 Frequently Asked Questions ............................................................................................................. 30
10. Uninstalling the DataMart Client ........................................................................................................ 30
Appendix A: Quick Reference for DataMart Administrators
1 Introduction
The Mini-Sentinel Distributed Query Tool is based on the PopMedNet™ software application that enables simple, efficient creation and use of distributed data networks, through a set of tools and web-based services. It is optimized to facilitate distributed analyses of medical product safety, comparative effectiveness, quality, medical resource utilization, cost-effectiveness, and related studies. The system provides secure, customized private portals, query tools, and file transfer capabilities. It supports both menu driven queries and distributed analyses using complex, single use or multi-use programs designed to execute against a local data resource.

Data partners exercise full control over the files they make available for querying, the results returned to requestors, and the individuals who are permitted to submit queries.

This Mini-Sentinel Distributed Query Tool DataMart Administrator Manual describes the main features and functions for DataMart Administrators responsible for query response through the Mini-Sentinel Distributed Query Tool. DataMart Administrators will interact with the Mini-Sentinel network through a secure web-based Portal and through the desktop DataMart Client as described below. This document is based on the FDA Mini-Sentinel Network’s implementation of the PopMedNet™ system, including the query types available for Mini-Sentinel.

The Department of Population Medicine at the Harvard Pilgrim Health Care Institute (HPHCl) led development of the system in collaboration with Lincoln Peak Partners (LPP). Lincoln Peak Partners provides support services and secure hosting for current system users, and leads development of system enhancements.

2 System Overview
The Mini-Sentinel Distributed Query Tool is comprised of two separate applications, the web-based Portal and the DataMart Client. There is one Portal in the network and each data partner has one or more “DataMarts”. The Portal is the starting point for all information requests and controls all system communications, security, and governance policies. Data Partners receive queries, process them, and securely return them to the Portal via their locally installed DataMart Client software application. Each Mini-Sentinel Data Partner will have at least one DataMart; multiple DataMarts per Data Partner are possible. Each DataMart can contain different types of data and DataMarts can have different query processing settings. All query requests and communications within the network are securely routed from the Portal to the DataMarts and then back to the Portal.

Note: The term DataMart is used in an information technology context referring to the place where the data are held for querying. Use of this term does not imply that data partner information is being sold or being made broadly available; Data Partners maintain control of all their data and all uses.

Browser Requirements
The Portal is designed to work with Internet Explorer (IE) 7 or later. Earlier versions of IE may not display the user interface properly. Although IE7 is the only officially supported browser, other browsers such as Firefox and Chrome may also work. Firefox has been used extensively during testing.
The DataMart Client Application

The DataMart Client application allows the DataMart Administrator to view queries distributed to the DataMart, execute queries locally, review the results, and upload the results to the portal. The DataMart Client is a .NET/C# Windows desktop application that is installed locally on an Administrator’s desktop. All communications between the DataMart Client application and the Portal use HTTP/SSL connections to securely transfer queries and results between the application and the Portal. The application uses ODBC connections to the local DataMart databases used to process queries and generate results.

Audience

This manual is intended for Mini-Sentinel Distributed Query Tool DataMart Administrators who want to:

- Install the DataMart Client
- Process queries distributed to the DataMart
- Administer DataMart settings and accessibility
- Add DataMarts
- Manage and audit DataMarts

Related Documents

For more information about the Mini-Sentinel Distributed Query Tool system, see one of the following documents:

Mini-Sentinel Distributed Query Tool Investigator Manual

The Investigator Manual describes the tasks and activities required for Mini-Sentinel Investigators to:

- Submit a query to the available DataMarts
- Monitor status of a query
- Review results of a query

The Investigator Manual also describes the types of queries and the criteria required for submission of each query type.

Mini-Sentinel Distributed Query Tool Group DataMart Administrator Manual

The Group DataMart Administrator Manual describes the tasks and activities required to manage results of a group. This includes:

- Viewing group results
- Approving group results

Mini-Sentinel Distributed Query Tool Network Administrator Manual

The Network Administrator Manual describes the tasks and activities required to install and manage the Portal. This includes:
• Installing an instance of a Portal and an associated database
• Performing the initial administrative setup
• Performing typical System Administrator functions such as adding new users and DataMarts, creating new roles, and deleting users and DataMarts

Mini-Sentinel Distributed Query Tool Overview and Technical Documentation

The Overview and Technical Documentation described the overall network system architecture, key querying features, and hosting and security details. This includes:

• System overview and workflow
• Policies and features
• Technical architecture and security

3 How to Login to the Web Portal

Before you can login to your Mini-Sentinel Distributed Query Tool network Website Portal, you need a username and password assigned by your Network Administrators at the Mini-Sentinel Operations Center. Once you have your Login Credentials, follow the steps below.

1. Navigate to the Mini-Sentinel custom website login page:
   [Secure URL distributed by Mini-Sentinel Operations Center].

2. Enter your assigned username and password in the boxes.

3. If this is your first login, you will be prompted to read and acknowledge your agreement to the Terms and Conditions of use. If you have cookies enabled on your web browser, you will not be prompted on subsequent logins.

4. Check the check box to agree to the Terms and Conditions of use (Initial Login only)
5. Click the Login button to enter the Mini-Sentinel website portal.

4 How to Install the DataMart Client
This section describes the installation setup of the DataMart Client for Mini-Sentinel.

Your local computer user account must have administrative privileges to install the DataMart Client.

Note: You do not need to uninstall a prior version of the DataMart client when installing a new, upgraded version of this software. This happens automatically. If for any reason, you do need to uninstall the DataMart Client, see Section 10: Uninstalling the DataMart Client.

There are three basic steps to setting up the DataMart Client:

- Download and install the DataMart Client
- Create an ODBC Data Source Name (DSN) for your DataMart. Note: This will help link your DataMart Client with your DataMart (database). The DataMart is created separately.
- Configure the DataMart Client to point to your ODBC DSN (DataMart)

4.1 Installing the DataMart Client
Use these steps to install the DataMart Client:

1. Login to the Mini-Sentinel web portal using your DataMart Administrator login credentials provided by the Mini-Sentinel Operations Center.
2. Click on DataMart under the Administration tab to display the DataMart Administration page.
3. Click the Download button at the bottom of the page to download the DataMart Client setup (Note: you may need to scroll to the bottom of the page to view).

4. When prompted, click Run:

![File Download - Security Warning]

5. In the next dialogue box, click Run again:

![Internet Explorer - Security Warning]

6. Click Next to begin the Setup:
7. Select the installation folder then click Next:

8. Click Next to confirm the installation:
4.2 Installing the Database (DataMart)

To connect a DataMart database to the DataMart Client, save the DataMart to the desired folder on your local computer or network. The DataMart database is usually a Microsoft Access database file that has an .mdb file extension. Other database types (for example, MySQL) are supported. All DataMarts within your Mini-Sentinel PopMedNet™ system are created separately under guidance of your Network Administrator or the Mini-Sentinel Operations Center.

For testing purposes, there is a sample database available on the DataMart Administration page. To download the sample database, click the download button at the bottom of the page. After you click the download button you will be prompted to save this file. The default name of the sample database is Demonstration Query Tool.mdb; this name may be changed upon saving the file.

Note: It is important to remember the folder (i.e., location) and file name of your saved database, as this will be required information when you establish your open database connectivity connection (i.e., connect your DataMart Client to your database location).

4.3 Creating an ODBC Connection

Once you have installed the DataMart Client and your database, you must create an Open Database Connectivity (ODBC) connection to your data source.

Use these steps to create an ODBC connection:

1. Go to Settings > Control Panel > Administrative Tools > Data Sources (ODBC):
2. Click on the System DSN tab and click the Add button.

3. In the Create New Data Source window, choose Microsoft Access Driver (*.mdb) and click Finish:
Enter the Data Source Name and locate the database:

a) Under Data Source Name, type the name of your data source, for example: **Mini_Sentinel_SummaryTables**.

b) Click the “Select” button to locate your database. Make sure to select your database from the folder that you saved it to in section 4.2 above. Click OK and then click OK again to save.

Note: the default name of the sample database is Demonstration Query Tool.mdb
4.4 Configuring your DataMart Client to use your ODBC Connection

Use these steps to configure the DataMart Client to use your ODBC connection:

1. Double-click on the DataMart Client icon on your desktop to open the DataMart Client.
2. Click on File > Settings

![File menu]

3. Click the Add button

![Network Settings page]

4. On the Network Settings page, enter the Network name, the Service URL, and your DataMart Administrator login credentials as follows:

   - **Network Name**: FDA Mini-Sentinel
   - **Service URL**: The production URL for the Mini-Sentinel site, provided to you by the Mini-Sentinel Operations Center.
   - **Username and Password**: Your login credentials, provided by the Mini-Sentinel Operations Center (the same credentials as logging into the Portal).
5. Click Login.

**Note:** Select the “Login Automatically” checkbox to save your credentials and login automatically without prompting for user name and password the next time the DataMart Client is launched. You can disable the automatic login feature.

On the Network Settings page select Edit to connect the DataMart Client to the DataMart using the ODBC connection. Use the Data Source dropdown menu to select the DataMart name you created in Section 4.3 Creating an ODBC Connection (e.g., select Mini-Sentinel Summary Tables). This is the DataMart that will be used when queries are sent to the DataMart. Any number of additional DataMarts can be created to direct queries to other data resources.

**Note:** If using the Mini-Sentinel Summary Tables, you should initiate an “Update Dates” query as described in section 6.2 Determining which Type of Queries to Allow once you have set up your ODBC connection. This ensures that data (i.e., query types) your DataMart has available and for what time periods are displayed on the Portal under your DataMart Administration page.
4.5 Configuring DataMart Client Settings

On the DataMart Client network settings page (see screenshot above), set the unattended operation and low cell count settings in accordance with the governance of your network and your local standard operating procedures.

4.5.1 Unattended Operation Settings

The Unattended Operation settings are tools that permit fully manual, semi-automated or fully automated query processing. If you select “Allow unattended operation”, unattended operation checks for new queries at the designated interval, and processes the queries according to the options you select. Enter the time interval in minutes. Users should minimize the application instead of logging out of the application so that automatic query processing takes place in the background - click ‘Close’ or minimize the Client from the Query List page.

**Unattended Operation Settings**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify me of new queries, but do not check</td>
<td>The DataMart Client checks for queries at the selected interval and notifies the DataMart Administrator via a pop-up</td>
</tr>
</tbody>
</table>

Developed by the Mini-Sentinel Operations Center.
process them automatically

Process new queries automatically but do not upload results

The DataMart Client checks for queries at the selected interval and processes the query automatically, but the DataMart Administrator must upload and review the query results manually.

Process new queries automatically and upload results

The DataMart Client checks for queries at the selected interval, processes the query automatically, and uploads the results. This option does not require any DataMart Administrator intervention in the process.

4.5.2 Low Cell Count Settings

The low cell count setting allows you to specify a cell count limit for results. This setting scans the query results for any individual cell that is less than the specified limit and highlights that row in yellow. Highlighting does not refer to and will not change calculated columns, see section 5.1.4. You can then choose to upload the results without changing the low cells or click “Change Count” to change the relevant cells to zero before uploading.

Note: If you select “Process new queries automatically and upload results” in the Unattended Operation settings, results will be uploaded regardless of the low cell count setting.

5 Processing Queries

Once you have configured the DataMart Client, you are now ready to process all queries distributed to your DataMart. As DataMart Administrator, you have the rights to perform the following operations on a query:
- Execute and review results
- Hold a query
- Reject query
- Change Cell Counts
- Upload Results

5.1 Displaying the Query List

Double-click the DataMart Client icon on the desktop to display the list of queries.

The Query List form displays the status of all queries across all Networks and DataMarts for which you are a DataMart Administrator. You can filter the display by Network, DataMarts, Query Status, and Date to show a subset of the queries submitted to your DataMarts. When you select a filtering option from the drop-down list, the Query List is refreshed automatically.

5.1.1 Filtering Options

Use the drop-down controls at the top of the screen or you may click on any column title to sort your list of queries (e.g., Network, DataMart Name, Created By, Request Time, Status and Response Time). You can filter by the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networks</td>
<td>The Networks drop-down list displays the list of networks that the DataMart application is subscribed to in addition to an “All” selection. Choosing a specific network selection populates the list with all queries from the chosen network. There will be at least one network.</td>
</tr>
<tr>
<td>DataMarts</td>
<td>The DataMarts drop-down list displays the DataMarts that you are connected to.</td>
</tr>
</tbody>
</table>
configured to administer within the selected Network(s) in addition to an “All” selection. Each network will have at least one DataMart.

### Status

The Status drop-down list allows you to view queries by status: Pending, Submitted, Completed, Awaiting Approval, Rejected, Cancelled, Pending Group DataMart Administrator Approval, In Progress, or Failed in addition to an “All” selection.

### Date

Go to File > Filter (or Ctrl + F). You can choose to filter the query list by preset time periods or by custom dates.

### 5.1.2 Query Status

When viewing queries by status, you can sort on the following options:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Displays all queries. Does not filter by status.</td>
</tr>
<tr>
<td>Pending</td>
<td>The query has been submitted to the DataMart, but not yet processed by the background service (HubBackgroundService). Pending is an intermediate state, usually very short. Once the background service has processed the query, it changes the status to Submitted.</td>
</tr>
<tr>
<td>Submitted</td>
<td>The query has been submitted to the DataMart and processed by the background service. Submitted and Pending both mean that an Investigator has submitted a query. The only difference is that the intermediate state of Pending gets changed to Submitted by the background service that polls the database for new queries. If the query status does not get changed to Submitted, the background service is not working.</td>
</tr>
<tr>
<td>Completed</td>
<td>The results of the query have been uploaded to the Portal. Queries are marked Completed when results have been uploaded by the DataMart Administrator (via DataMart Client) or by the Server DataMart.</td>
</tr>
<tr>
<td>Awaiting Approval</td>
<td>The query has been received by the DataMart but requires approval from the DataMart Administrator before it is executed. The DataMart Administrator can set a query to Awaiting Approval by clicking the Hold button in the Query Detail view of the DataMart Client. See Section 5.3 Holding Queries. After further review, you may upload the queries you hold that are Awaiting Approval.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The query has been rejected by the DataMart Administrator. The DataMart Administrator sets the query state to Rejected by clicking the Reject button in the Query Detail view of the DataMart Client. See Section 5.4 Rejecting Queries. Rejecting a query ends the life of the query submitted to that DataMart.</td>
</tr>
</tbody>
</table>
| Cancelled               | The Investigator has removed the DataMart from the query. Removing DataMarts from a query marks the status of the query for the removed DataMart as Cancelled. Note: The Investigator cannot remove a particular
Pending Group DataMart Administrator Approval

The query has been received by the DataMart but requires approval by the Group DataMart Administrator, if applicable. All results uploaded by DataMarts that are part of the Group’s organizations require this approval. The uploaded results are withheld from the Investigator unless approved by the Group DataMart Administrator.

In Progress

The query has been processed at the DataMart Client but uploading the results has not finished. For example, if you have selected “Process new queries automatically but do not upload results” in the DataMart Client settings, you might see the In Progress status. See Section 4.5.1 Unattended Operation Settings.

Failed

The query encountered errors while processing or failed to upload results.

Note: Running a query does not change the query’s status.

5.1.3 Viewing Query Details

Highlight an entry in the list and click the View Detail button to open the Query Detail view. You can also double-click an entry in the results list.

5.1.4 Query Result Parameters

Current Mini-Sentinel Database Parameters:

- Query Category: Prevalence (Prev)
- Query Types:
- **Enrollment**
  - Drug and Medical Coverage
  - Medical Coverage Only
  - Drug Coverage Only
  - All Members (which represents a the union of previous 3 coverage types)
- **HCPCS (Healthcare Common Procedure Coding System)**
- **ICD 9 Diagnoses (3 Digit Codes)**
- **ICD 9 Diagnoses (4 Digit Codes)**
- **ICD 9 Diagnoses (5 Digit Codes)**
- **ICD 9 Procedures (3 Digit Codes)**
- **ICD 9 Procedures (4 Digit Codes)**
- Pharmacy Dispensings by Generic Name
- Pharmacy Dispensings by Drug Class
- **Sex Stratifications:**
  - Female: F
  - Male: M
  - Male and Female Aggregated: All
- **Age Stratifications:**
  - 10 Stratifications: 0-1 years, 2-4, 5-9, 10-14, 15-18, 19-21, 22-44, 45-64, 65-74, 75+
  - 7 Stratifications: 0-4, 5-9, 10-18, 19-21, 22-44, 45-64, 65+
  - 4 Stratifications: 0-21, 22-44, 45-64, 65+
  - 2 Stratifications: Under 65, 65+
  - 0 Stratifications: 0+
- **Periods:** Yearly, depending on the availability within your database. Pharmacy Dispensings queries may be have quarterly availability
- **Calculated Columns**
  - **Medical Queries:** HCPCS Procedures, ICD-9 Diagnoses and Procedures
    - Total Enrollment in Strata (Members)-Total count includes members with both medical and drug coverage plus those with medical coverage only.
    - Incidence/Prevalence Rates (Users per 1000 enrollees)
    - Event Rate (Events per 1000 enrollees)
    - Events per Member
  - **Drug Queries:** Pharmacy Dispensings by Generic Name and Drug Class
    - Total Enrollment in Strata (Members)- Total count includes members with both medical and drug coverage plus those with drug coverage only.
    - Incidence/Prevalence Rates (Users per 1000 enrollees)
    - Dispensing Rate (Dispensings per 1000 enrollees)
    - Days per Dispensing
    - Days per user

### 5.2 Executing and Uploading Queries

You can execute a query by clicking Run Query in the Query Detail view. This action will pull the query from the Portal to run against your selected data source. Results will be displayed in the Results window. Click on the Upload results button to upload the results of the query to the Portal. You may leave a comment, as seen in the screenshot below, if you would like to provide additional information with your results. The query requestor will see these comments along with the results on the portal.
In the case of multiple DataMart Administrators for one DataMart, the ‘Upload Results’ button will grey out once one DataMart Administrator uploads results. After results have been uploaded, you may still review the results that have been uploaded by clicking Run Query. However, you will not have the option to upload the results again.

5.3 Holding Queries
You can put a query on hold to notify the requestor that you have received/executed the query but have not yet uploaded results for it. To do this, click Hold in the Query Detail view and include comments, if necessary. The query status on the Portal will change from submitted to “Awaiting Approval” and any comments will be sent to the requestor. Depending on the approval, you may then upload results or reject the query.

5.4 Rejecting Queries
Queries can be rejected before or after execution. To reject a query, click Reject in the Query Detail view. You have the option to provide a reason for the rejection. The query status on the Portal changes to Rejected and the reason is provided to the requestor.

6 Administering Your DataMart
As the DataMart Administrator you can perform several tasks on your Mini-Sentinel Network Web Portal. These tasks are:

- Viewing overview information (metadata) about network DataMarts
- Managing your DataMarts
- Selecting which types of queries to allow
- Selecting who can submit queries to your DataMart
- Creating an audit report of the DataMart
6.1 Viewing DataMart Information

You can view overview information for any network DataMart.

Select DataMart on the Network tab to view metadata for any network DataMart.
To view the metadata for a specific DataMart, choose the DataMart from the DataMart drop-down list.

**Note:** The View DataMarts page only displays the information. You cannot update it from this page.

### 6.2 Managing Your DataMarts

You can manage multiple DataMarts through the DataMart Administration screen. Use the DataMart Administration screen to manage DataMart information such as contact information, special requirements, or descriptions of organizations, usage restrictions, etc. You can also add or remove other administrators of the DataMart.

Select DataMart on the Administration tab to go to the DataMart Administration page, where you can view a list of your DataMarts.
Click on the name of the DataMart that you want to manage.

The DataMart Administration screen displays the settings for the DataMart that you selected. You can view and update the contents of your DataMart from this screen. You may also add/remove DataMart Administrators. Be sure to click ‘Save DataMart’ at the bottom of the page after making any changes.

6.3 Determining which Types of Queries to Allow

Before you can determine which types of queries to allow you must first determine what queries your DataMart has available and for what time period.

To make this information available on your Portal DataMart Administration page:

1. Select all the queries you plan to include within the Supported Queries section by checking each query type.
2. Click on Save DataMart. This will bring you back to your list of DataMarts.
3. Click back into your DataMart.
4. Click Update Dates. This will send a Refresh Dates query to your DataMart Client application.
5. Open up your DataMart Client and once in the Query List, select View Details and Run Query to upload the results to the Portal. After you accept the Refresh Dates query the Portal will have the information regarding queries your DataMart has available.
6. Go back into the Portal and click into your DataMart. The available dates next to each query type should now be shown in the Supported Queries section.

You must check the box next to each query type that you want to allow. There is no “select all” function. If you do not select a query type, no one in the network will be able to submit that type of query to your DataMart. You may change the query type selections at any time. Save your DataMart after making your selections.

<table>
<thead>
<tr>
<th>Supported Queries:</th>
<th>Prevalence</th>
<th>Prevalence</th>
<th>Prevalence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Type</td>
<td>Annual Data Availability</td>
<td>Quarterly Data Availability</td>
<td></td>
</tr>
<tr>
<td></td>
<td>From</td>
<td>To</td>
<td>From</td>
</tr>
<tr>
<td>Prev. Pharmacy Dispensings by Generic Name</td>
<td>2016</td>
<td>2018</td>
<td>2016Q1</td>
</tr>
<tr>
<td>Prev. Pharmacy Dispensings by Drug Class</td>
<td>2016</td>
<td>2018</td>
<td>2016Q1</td>
</tr>
<tr>
<td>Prev. Dispensings by National Drug Code</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prev. ICD-9 Diagnoses (3 digit codes)</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. ICD-9 Procedures (3 digit codes)</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. HCPCS Procedures</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. Enrollment</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. ICD-9 Diagnoses (4 digit codes)</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. ICD-9 Diagnoses (5 digit codes)</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
<tr>
<td>Prev. ICD-9 Procedure (4 digit codes)</td>
<td>2016</td>
<td>2018</td>
<td></td>
</tr>
</tbody>
</table>

6.4 Determining Who Can Submit Queries to your DataMart

Click the Permissions button to administer the permissions and access control settings for the DataMart. The settings allow you to choose specific groups, organizations, or users that you authorize to submit queries to the DataMart.

You can give permission to query your DataMart to Groups, Organizations, or Users. If you give permission to a Group, then every user in every organization that is part of the group will be permitted to query that DataMart. For example, if Kaiser Permanente is a group and Kaiser Permanente Colorado and Kaiser Permanente Georgia are members of the group, then allowing the Kaiser Permanente group to query the DataMart also allows all users associated with Kaiser Colorado and Georgia to query the DataMart. Giving permission to specific organization means that all users affiliated with the organization...
will have the ability to query the DataMart. Access to a DataMart also can be determined on a user-by-
user basis.

Use the Add and Remove buttons to make and modify selections. The permissions can be changed at
any time.

### 6.5 Creating an Audit Report

Click the Audit Report button on the DataMart Administration page to request an audit of any of your
DataMarts. The Audit Report allows you to view all the activity that has been requested from any of
your DataMarts.
Select the start and end dates for your report, whether you want a summary or a detailed report, and how you want the data fields in the report to be ordered. Click the PDF Report button to create the report. This creates a file named DataMartAuditSummaryReport.pdf or DataMartAuditReport.pdf depending on whether you choose Summary or Detail, respectively.

7 Notification Options
This section describes how to set up notifications to be sent to your email address. You must be logged in as the DataMart Administrator to change DataMart Administrator notification settings. Click Notification Options on the Notifications tab at the top of the page to display the Notification Options page.

The Notification Options page lists the types of DataMart transactions and events for which you can enable email notification. It includes both Investigator notifications and DataMart Administrator notifications. Many of these notification choices are intended to give DataMart Administrators information about any changes made to the settings of their DataMarts.
The Notification Options for the DataMart Administrator are:

**DataMart Client Update Notification**
For Datamart Administrators: Email notifications are sent to the DataMart Administrators. It alerts these administrators that the new version of the DataMart Client application is available for download.

**Results Viewed**
Notifies you when an Investigator views the results of a query

**Query Type Added**
Notifies you when a new query type has been added to the list of supported query types for your DataMart

**Query Type Removed**
Notifies you when a query type is no longer supported for your DataMart

**New User**
Notifies you when a new user has been added to the list of those allowed to send queries to your DataMart

**User Removed**
Notifies you when a user has been removed from the list of those allowed to send queries to your DataMart

**New Organization**
Notifies you when an Organization has been added to the list of organizations that can send Queries to your DataMart

**Organization Removed**
Notifies you when an Organization has been removed from the list of organizations allowed to send queries to your DataMart

**New Group**
Notifies you when a group has been added to the list of groups allowed to send queries to your DataMart

**Group Removed**
Notifies you when a group is removed from the list of groups allowed to send queries to your DataMart

**New Query**
Notifies you when a new query has been submitted to your DataMart and requires your action to process it

**User Profile Updated**
Notifies you when a user has updated his/her user profile

**Query Reminder**
Notifies you when a previously submitted query is still pending and requires your attention in order to process it

The notification options for the Investigator role are:

**Query Status Change**
Notifies you when your submitted query has been on placed on hold or rejected by the DataMart administrator that you submitted the query to.
New Results  
Notifies you when the DataMart administrator has accepted your query and the query results have been uploaded.

Query Submitter Reminder  
Notifies you when one or more DataMarts have not uploaded results for the query submitted.

8  Administering or Changing your User Profile

This section describes how to administer your user profile. You must be logged in to the web portal to administer your user profile. Click Users on the Administration tab located at the top of the screen. The screen displays your user profile.

![User Administration](image)
8.1 How to Reset your Password

Your user profile has two boxes for passwords. To change your password:

1. Enter the new password in the first Password box.
2. Re-enter the new password in the second Password box.
3. Click the Save button.

**Note**: All passwords must meet the following complexity standard:

- Length must be at least 7 characters
- Password must include at least 1 upper case letter, 1 lower case, 1 number, and 1 symbol.
- Passwords may not be reused

Once you initially get your login credentials from the Network Administrator, it is highly advised that you change your password from the default password given to you.
9 Getting Help

Once logged in, the Resource Tab offers helpful contact information, documentation, and related links, as seen below.

If you have trouble accessing the Web Portal or your user account, click on the Contact Us link on the login page and describe your issue in the email. To request additional help contact your Network Administrator or the Mini-Sentinel Operations Center support staff directly.

9.1 Development and Funding Statement

The PopMedNet™ software application was developed as part of several contracts awarded by the Agency for Healthcare Research and Quality to the HMO Research Network (HMORN) Center for Education and Research on Therapeutics (CERT) DECIDE Center housed in the Department of Population Medicine at the Harvard Pilgrim Health Care Institute (HPHCI). The software application has been enhanced using additional funding via the FDA Mini-Sentinel contract with Harvard Pilgrim Health Care. The system was developed by Lincoln Peak Partners under the direction of HPHCI.
9.2  Frequently Asked Questions
This section lists some of the most frequently asked questions.

What is the difference between Groups, Organizations, and Users?

A user is a person who has login credentials to the network Portal. Users are associated with one Organization. Organizations can be associated with one or more Groups. A Group is a set of network Organizations and can only be created by the System Administrator. A user is typically associated with their employer organization. Organizations can be Data Partners (for example, Kaiser Permanente Colorado), federal agencies (for example, FDA, NIH), or affiliated institutions such as academic medical centers.

Users are individuals with various roles and associated rights within the system such as Investigator, DataMart Administrator, and System Administrator.

What are my rights as a user and how can I change them?

Rights can only be assigned to various roles by the System Administrator. The System Administrator can also assign rights to multiple users by giving that right to an Organization or Group.

Where can I get more information on the PopMedNet™ application?

You may contact the Mini-Sentinel Operations Center for more information:

Jeffrey Brown, PhD
Harvard Pilgrim Health Care Institute
Jeff_brown@hphc.org

10  Uninstalling the DataMart Client
Use these steps to uninstall the DataMart Client:

1. Go to “Control Panel > Add / Remove Programs” or “Control Panel > Programs and Features” depending on which version of Windows you are using.
2. Double click “DRN 2.0 Data Mart Client” in the list of installed items displayed
3. Click Yes in the pop up dialog box, “Are you sure you want to uninstall DRN Data Mart
Client”

**Note:** Uninstalling and installing software on operating systems like Vista might require
additional authorization due to the enhanced security features (user account controls) built in to
the operating system. Click “Yes” when prompted.

(No action required) **Note:** A success message will be displayed upon successful removal of the
DataMart Client.

## 11 Clearing your Event Log

Should your DataMart Client Event Log fill up, you will need to clear its contents in order to continue
using the Client. Follow these steps to do this:

1. Go to Start > Run
2. Type in “eventvwr” into the search bar, if it is not already showing:
The Event Viewer Screen will open:

3. Right click on the ‘Application’ icon and select “Clear All Events.” (Using the icon in the left or right section will produce the same outcome.) Save the event log should the file need to be reviewed for system errors. Your DataMart Client should now be able to continue functioning.
Appendix A: Quick Reference for DataMart Administrators

1. How to Submit a Summary Query to your Own DataMart(s)
   a. Log into the Portal with your **DataMart Administrator** credentials.
   b. Select the Summary Query button on the main page or from the **Queries** tab.
   c. Complete the Summary Query form by entering a name, brief description of the query, and selecting the relevant parameters.
   d. Select your DataMart.
   e. Select **Start this Query**.

2. How to Execute a Query Submitted to your DataMart
   a. Open your Desktop DataMart Client and log in (**DataMart Administrator** login)
   b. New queries are displayed in the “query list” as “submitted”. Click “refresh” to ensure the query list is up to date.
   c. To view the query, highlight the row and select **View Details** (or double click to open). You are now in the **Query Detail screen**.
      • **Summary Query**
        1. To execute the query, click **Run Query**. The results will appear in the Results pane of the window.
      • **File Distribution**
        1. To open and download the file, select the files you wish to open one at a time at the bottom of the window under the “files attached to this query” section.
        2. Click on **Add** to select a file you would like to send back to the data partner who sent you the original file (e.g., responding to a work-plan or replying with file revisions).
           a. Note: you can send back multiple files by clicking **Add** to browse and add a new file.
        d. To upload results to the Portal, click **Upload Results**. You may include comments with your results, if necessary.

3. How to View Results on the Portal
   a. Log into the Portal with your **DataMart Administrator** Login and go to the **Results** tab.
   b. Click on **View Details** to view query details.
   c. Click **View Result** to see a table with the requested data.
   d. Export data to Excel/CSV for review.